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摘要 

本研究目的是為了表現在聚亞醯胺基材添加二氧化矽奈米顆粒之奈

米複合材料的機械性質，於提出連體微觀力學模型。藉由分子動力學

建立並且模擬奈米複合材料，可以在奈米等尺寸的內含物以及周遭的

基材部分之間發現凡得瓦間距以及非鍵結能量，而正交化非鍵結能量 

(非鍵結能量除上內含物的表面積)和介面層的鍵結相關，考慮非鍵結

間距即為介面層厚度，並且利用線彈簧模型模擬正交化的非鍵結能量

進而計算出介面層的剛性，接著利用等效介面層模型，包括內含物，

基材以及介面層，利用此模型模擬奈米複合材料的機械性質，將結果

與分子動力學分析結果比較，利用等效介面層模型能夠準確的描述奈

米複合材料的楊氏模數，另外研究也發現當顆粒大小降低時，奈米複

合材料的楊氏模數會上升。 
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Abstract 

This research aims to propose a continuous micromechanical model for characterizing 

the mechanical properties of the nanocomposites containing silica nano-particles 

embedded in polyimide matrix.  The molecular structure of the nanocomposites was 

established through molecular dynamic (MD) simulation, from which the non-bond 

gap as well as the non-bond energy between the nano-sized inclusion and the 

surrounding matrix was evaluated.  It was postulated that the normalized non-bond 

energy (non-bond energy divided by surface area of the inclusion) is correlated with 

the interfacial interaction.  Subsequently, a three phase micromechanical model 

including inclusion, matrix and effective interface was developed, in which the 

dimension of the effective interface was assumed equal to the non-bond gap and the 

corresponding stiffness was calculated from the normalized non-bond energy with the 

assistance of a linear spring model.  Comparison of the results calculated from the 

micromechanical model and the MD simulation indicates that the three phase 

micromechanical model is capable of describing the Young’s modulus of particulate 

nanocomposites with accuracy.  In addition, it was also found that with the reduction 

of the particulate size, the modulus of the nanocomposites become increasing. 
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第一章 序論 

1-1  簡介以及文獻回顧 

    複合材料(Composite)，簡而言之就是由兩種或兩種以上的材料，

及加強材(Reinforcement)以及基材(Matrix)之間沒有化學變化所組成

的材料，在加強材部分可依照添加的形式而成下列幾種型式的複合材

料： 

1. 纖維狀複合材料(Fibrous Composite)：由連續或切斷纖維組

成，一般採用碳纖維(Graphite fiber)或是玻璃纖維(Glass fiber)

當作加強材。 

2. 層狀複合材料(Laminated Composite)：由單層或多層的構成要

素所組成的複合材料。 

3. 粒狀複合材料(Particulate Composite)：由粒子所組成，一般採

用金屬氧化物當作加強材。 

    在基材部分大致可分為：(1) 高分子聚合物(Polymer) (2) 陶瓷材

料(Ceramic) 以及(3) 金屬(Metal)材料，其中高分子聚合物價格低

廉，重量輕且容易製造，因此一般採用高分子聚合物作為基材，但機

械性質普遍不佳，所以需要添加加強材以提升其機械性質，常見的方

法便是在高分子聚合物中添加球狀顆粒，一般來說，添加於複合材料

的強化顆粒尺寸為微米(Micro)級的尺寸，但是由於奈米科技在近幾年

技術的發達以及成熟，使得強化顆粒的尺寸已經能達到奈米

(Nanometer)等級並且能夠均於的分散在高分子基材中，這種複合材料
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即為奈米複合材料 (Nanocomposite)。在傳統連體力學 (Continue 

mechanical)的觀點中，假設複合材料的加強材皆為球狀顆粒，且體積

比(Volume fraction)也相同，則顆粒大小對於複合材料的機械性質並沒

有任何的影響，比較兩個代表性之體積元素(Representative Volume 

Element, RVE)模型，其中基材以及加強材的機械性質如表 1-1，考慮

擁有相同的體積比，但是球狀加強材的大小不相同，如圖 1-1，則藉

由有限單元法(Finite element method)計算 RVE 的楊氏模數，結果如表

1-2，以發現這兩個 RVE 模型擁有相同的楊氏模數，藉由上述分析，

可以知道添加球狀顆粒於高分子聚合物中，顆粒的大小並不會影響複

合材料的楊氏模數。 

    然而，近年來許多的學者在研究顆粒大小對於複合材料機械性質

的影響性中發現顆粒大小對於複合材料的機械性質還是產生一些影

響，這項結果和傳統連體力學的結論恰好相反，在這些學者的研究當

中，有些實驗結果顯現當顆粒大小降低至奈米尺寸(Nano-scale)時，由

於表面接觸的面積增加導致奈米複材的機械性質上升[1-5]。另一方

面，有些研究卻發現相反的結果 [6-13]，由上述的結果，可以發現並

沒有一個統一的結論來論證添加奈米顆粒對於機械性質是否比添加

微米顆粒的機械性質更為優異，或是更差，或是沒有影響。到目前為

止，仍然有許多的學者針對此問題作持續的探討。 

    Chen 和 Sun [1] 以氫氧磷灰石 (hydroxyapatite, HA) 作為加強材

的部分，將顆粒狀氫氧磷灰石加入聚己內酯 (poly(ε-caprolactone), 

PCL) 聚合物中，氫氧磷灰石的顆粒大小分別為 3-8µm 以及 

20-80µm，而聚己內酯考慮兩種不同的分子量(Molecular weight)，Chen

和 Sun 發現當氫氧磷灰石的顆粒越小，則和聚己內酯接觸的面積越

 2



大，複合材料的降伏強度(Yield strength)、抗張模數(Tensile modulus)、

儲存模數(Storage modulus)以及損失模數(Loss modulus)都會獲得改

善，另外藉由示差掃描熱量分析儀(Differential scanning calorimetry, 

DSC)分析，可以發現聚己內酯的分子量分佈越集中，則會有較強的

交互作用。Nazhat 等人 [2] 則是研究將氫氧磷灰石顆粒加入聚乙烯

(polyethylene, PE)中，氫氧磷灰石的顆粒大小分別為 4.53 µm 以及 

7.43 µm，並且比較體積比分別為 0.1%、0.3%以及 0.45%的機械性質

而實驗測量溫度分別為 20°C、30°C、37°C、45°C、60°C、80°C 以及

100°C，研究發現在體積比較低時(0.1%以及 0.3%)，氫氧磷灰石顆粒

較小則複合材料的儲存模數較大，但是當體積比為 0.45%並且溫度高

於 60°C，則較大氫氧磷灰石顆粒的複合材料擁有較高的儲存模數，

在這個研究中並沒有針對此現象做一個相關探討，此外，顆粒大小對

於針對阻尼比(Damping ratio)的部分並沒有明顯的差別。 

    Chisholm 等人 [3]  則是研究在環氧樹酯(Epoxy)中添加碳化矽

(Silicon carbide, SiC)顆粒，顆粒大小分別為  29nm(奈米尺度 )及

1µm(微米尺度)，Chisholm 等人研究發現添加奈米尺度的碳化矽顆粒

於環氧樹酯中比添加微米尺度的碳化矽顆粒有較好的抗拉模數、強度

以及熱性質，而添加微米尺度的碳化矽顆粒對於複合材料的勁度並沒

有任何的提升，另外研究發現當環氧樹酯藉由超音波(Sonication)震盪

之後其抗拉模數比沒有震盪過的環氧樹酯要高，對於添加奈米尺度的

碳化係顆粒能夠改善複合材料的機械性質可能是因為奈米尺度的顆

粒能夠加強高分子聚合物的結晶度 (Crystallinity)以及交聯反應

(Cross-linking)，造成表面能量(Surface energy)的增加。Vollenberg 等

人 [4, 5] 研究加強材顆粒大小以及顆粒表面的處理對於複合材料的

抗拉模數的影響，加強材顆粒分別為氧化鋁珠(Alumina bead)以及玻
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璃珠(Alumina bead)，顆粒大小分別為 0.0035 µm 至 100 µm，研究發

現當表面未處理的氧化鋁珠以及玻璃珠加入聚合物中，則楊氏模數

(Young’s modulus)隨著粒徑降地而增加，原因在於顆粒粒徑降低則表

面積增加，因此能夠增加與高分子聚合物的接觸面積，使得顆粒能夠

有效的吸附住礦物油(mineral oils)以及存在高分子聚合物中低分子量

的材料，若能藉由增加的表面積吸附更多的礦物油以及存在高分子聚

合物中低分子量的材料，則複合材料的楊氏模數將會提升，然而若加

強材顆粒的表面有事先處理，則在加強材顆粒以及高分子聚合物中可

能造成非常強或是非常弱的吸附力導致複合材料的楊氏模數不受顆

粒的大小影響。 

    上述所提及的文獻驗證對於加強材顆粒尺寸下降，則複合材料的

機械性質會上升，但是有些學者研究中發現尺寸對於複合材料的機械

性質並沒有影響甚至使得材料的機械性質下降。 Cho 和Sun [6] 探討

將玻璃珠以及氧化鋁珠加入乙烯基酯(Vinyl Ester, VE)中，粒徑大小分

別由 2mm 至 50nm，研究發現粒徑大小對於楊氏模數並沒有影響，

但是破裂強度(Failure strength)隨著粒徑下降而上升，當顆粒尺度在微

米尺寸時，破裂的主要原因是由於加強材顆粒以及基材之間的分離造

成，而當顆粒尺度達到奈米尺寸，則觀察試片的破裂情形可以發現在

基材部分也開始產生裂紋，本篇文獻中並沒有清楚的解釋抗拉強度為

何會和加強材顆粒大小有關。Ng 等人 [7] 選擇加強材為二氧化鈦

(titanium dioxide, TiO2)顆粒，顆粒尺寸分別為 32nm 以及 0.24µm，

基材部分選擇雙環氧基之環氧樹脂(diglycidyl ether bisphenol A , 

DGEBA)，比重為 1.17g/cm3，研究發現添加 32nm 以及 0.24µm的二

氧化鈦顆粒於雙環氧基之環氧樹脂中擁有相同的楊氏模數，但是添加

32nm強化顆粒複合材料擁有較好的延展性。Reynaud 等人 [8] 研究
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將矽顆粒加入聚酯纖維 6 (Polyamide 6, PA6)中，粒徑大小分別為

17nm、30nm以及 80nm，研究發現當加強材的粒徑下降時，複合材料

的的降伏強度會上升，但是Reynaud 等人也觀測出加強材的粒徑大小

對於複合材料的楊氏模數並沒有影響。 

    Li 等人[9] 探討以低密度的聚乙烯(low density polyethylene，

LDPE)為基材，玻璃珠為加強材，粒徑大小由 4µm 至 180 µm，研究

發現粒徑改變對於複合材料的損失因子(Loss factor)並沒有明顯的影

響，觀測中發現粒徑較小的加強材較容易在基材中均勻分散，而粒徑

較大的加強材由於密度較高而且表面較光滑，因此不容易在基材中分

散均勻。 Cho 等人 [10] 以玻璃珠以及氧化鋁珠為加強材，乙烯基

酯為基材，其中玻璃珠的粒徑由 500 µm 至 6 µm，而氧化鋁珠的粒徑

由 70 µm 至 15nm， 研究發現粒徑大小在微米尺度時粒徑的改變對

於楊氏模數並不會造成影響，但是當粒徑大小達到奈米尺度時，則楊

氏模數會由於粒徑大小降低而增加，此外抗拉強度也隨著粒徑大小降

低而增加。 Lopez 等人[11]探討以氧化鋁顆粒為加強材，而乙烯基酯

為基材，氧化裡粒徑分別為 3 µm、1 µm 以及 1nm，研究發現當氧化

鋁顆粒的粒徑下降，則複合材料的黏滯性(Viscosity)會上升，主要原

因在於氧化鋁顆粒以及乙烯基酯之間的離子吸引，導致在這兩者之間

的有效鏈長增加，另外也發現當粒徑越小，則複合材料的介電常數

(Dielectric constant)增加，其原因在於加強材粒徑越小，時能夠更快

速整齊的沿著電場方向排列，此外添加氧化鋁顆粒會造成複合材料的

抗拉強度下降。Adrian 等人[12] 利用分子動力學模擬探討巴克球

(Bucky-ball)添加於高分子聚合物的機械性質，研究結果發現當巴克球

粒徑越小，則複合材料的機械性質有明顯的上升，另外在高分子聚合

物以及巴克球之間的非鍵結力與探討粒徑大小對於複合材料的楊氏
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模數的影響有明顯的關係。Odegard 等人[13]利用分子動力學模擬二

氧化矽顆粒添加於聚亞醯胺(Polyimide, PI)聚合物中，分別考慮為改

質二氧化矽顆粒，表面添加氫族群的二氧化矽顆粒，表面添加苯基酚

(Phenoxybenzene)族群的二氧化矽以及在表面加入官能基使能夠與聚

亞醯胺聚合物產生鍵結的二氧化矽顆粒，探討不同類型的加強材對於

複合材料的楊氏模數影響，結果發現奈米複材除了添加表面加入官能

基的二氧化矽顆粒與聚亞醯胺聚合物的楊氏模數相同之外，其他的皆

低於聚亞醯胺聚合物的楊氏模數。Jordan 等人 [14] 提供許多關於改

善奈米複材的機械性質的文獻，包括改變加強材的顆粒大小、形狀、

體積比、分散於基材的程度以及在基材和加強材之間的現象。 

    最後有關於介面層的研究，Wang 等人[15] 以二氧化矽為加強

材，環氧樹酯為基材，探討在二氧化矽顆粒以及環氧樹酯之間的介面

層現象，Wang藉由掃瞄式電子顯微鏡(Scanning Electron Microscope, 

SEM)觀察在室溫以及 115P

O
PC下破裂面的情形，常溫時破裂面並沒有發

現任何的非彈性變形，另外也沒有看見加強材與基材之間脫層的現

象，因此可以確定二氧化矽顆粒與環氧樹酯鍵結的非常的好，主要破

裂在於環氧樹酯部分，而在 115P

O
PC時，可以觀察出在基材部分變的非

常的柔軟，但是依然可以發現二氧化矽顆粒被一層環氧樹酯包覆住，

並沒有脫層的現象，由上述的結果，Wang認為在介面層部分的鍵結

力比基材部分要來的高，另外在壓痕實驗中測得加強材，介面層以及

基材的硬度分別為 7.44GPa、1.82GPa以及 0.4GPa，也顯示了介面層

的強度大於基材。 

    Cannillo 等人[16]利用二氧化矽為加強材，聚己內酯為基材，其

中加強材粒徑為 100 至 200nm，分別考慮兩種加強材，一為表面改質
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二氧化矽顆粒，另一種則是在二氧化矽顆粒表面嫁接(Grafting)氫氧族

群，其主要目的為能夠使二氧化矽更容易分散在聚己內酯中以及加強

和聚己內酯的鍵結，經由實驗結果和 Halpin-Tsai 方程式以及

Lewis-Nielsen 方程式比較，發現添加有改質的二氧化矽顆粒的複合材

料楊氏模數高於理論值以及添加為改質的二氧化矽顆粒的複合材

料，並且在加強材以及基材之間可觀測出介面層的存在，Cannillo 等

人直接定義介面層的厚度為 0.5nm，楊氏模數則取基材與加強材楊氏

模數的平均，為 40GPa，成功的模擬出複合材料的楊氏模數。 

    Gao 和 Mäder[17]研究將玻璃纖維添加入聚丙烯(polypropylene, 

PP) 以及環氧樹酯中，玻纖的平均半徑為 13 至 31 mµ ，如圖 1-2，藉

由原子力顯微鏡(Atomic force microscope, AFM)觀測，可觀測出在玻

纖以及聚合物之間存在著一介面層，並且此介面層有較高的楊氏模數

進而增強複合材料的抗拉強度以及衝擊韌性(Impact toughness)。 

 

1-2  研究方法 

    本文利用分子動力學(Molecular dynamic, MD)模擬當奈米粉體添

加於高分子聚合物時的微觀現象以及機械性質，包括密度分佈

(Density distribution)，楊氏模數等等，並且探討奈米粉體與高分子聚

合物之間的作用關係以及對於楊氏模數的影響性，並且嘗試以傳統連

體力學模擬介面層(Interface)的機械性質，進而求得奈米複材的楊氏

模數。 
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第二章 分析步驟 

    本章將介紹如何利用分子動力學模擬合理的聚亞醯胺單位原子

結構模型以及聚亞醯胺-二氧化矽奈米複材結構模型，並且分析其複

合材料模型密度分佈、徑向分佈函數(Radial distribution function, RDF)

以及楊氏模數，並且計算非鍵結間距(non-bond gap)。 

 

2-1 分子動力學模擬 

2-1-1 建立奈米複合材料模型 

    首先利用分子動力學，模擬二氧化矽奈米粉體及其周遭聚亞醯胺

分子的微結構，我們使用 Material Studio(MS) 4.0 套裝軟體來進行分

子動力學的模擬，此軟體具有 Graphical User Interface(GUI)介面，而

且內建許多力場，可以直接藉由此軟體模擬分子內原子間及分子間彼

此交互關係。奈米複合材料的基本原子分子結構藉由 MS 中的

Amorphous Cell 模組所建立，再利用 Discover 模組進行相關的分子動

力學模擬運算以求得最佳的材料微結構模型，並利用此模型計算材料

的密度及其楊氏模數。 

    在分析奈米複材的密度分佈以及楊氏模數之前，我們必須要建立

合理的材料分子結構模型，其步驟如下： 

1. 建立聚亞醯胺的單位分子結構。由於聚合物是由同一種單位

分子所組合而成，所以必須建立聚亞醯胺的單位分子結構才
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能進一步的建立聚合物，圖 2-1 為聚亞醯胺單位分子的結構

式，利用 MS 軟體的 GUI 介面功能，可以建立聚亞醯胺單位

分子結構模型，如圖 2-2 所示，其中白色球體為氫原子，灰

色球體為碳原子，紅色球體為氧原子以及藍色球體為氮原

子，詳細步驟可以參閱附錄 1。  

2. 建立聚亞醯胺分子鏈，聚亞醯胺分子鏈是由許多的聚亞醯胺

單位分子結構所組成，利用 MS 軟體建立一條內含 10 個聚亞

醯胺單位結構的聚亞醯胺分子鏈，詳細步驟可以參閱附錄 2。 

3. 建立二氧化矽奈米粉體，利用 MS 軟體建立二氧化矽晶格結

構並在內部截取半徑範圍 10Å 以內的二氧化矽球體模型，此

球體模型中離球心最遠的原子距離為 9.78Å，如圖 2-3(a)，詳

細步驟可以參閱附錄 3。 

4. 建立初始奈米複材結構模型，利用 Amorphous Cell 模組建立

兩種結構模型： 

 

(1)  聚亞醯胺單位原子結構模型，此模型由 7 個聚亞醯胺分

子鏈所構成，結構模型採用 Compass 力場[18][19]，此力

場是第一個將以往分別處理的有機分子體系以及無機分

子體系的力場統一個分子力場，不同的體系採用不同的

模型，即使對於兩種體系的混合，仍然可以採用合理的

模型描述。Compass 力場藉由基本原理(ab initio)計算方

法，計算分子內的鍵結參數，同時又採用以液態分子動
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力學為基礎的經驗法則預測凡得瓦非鍵結的參數。也就

是說除了通常製作分子力場考慮的兩個實驗參照之外，

他還採用液態密度作為參數化的實驗標準，從而得到優

於其他分子力場的計算結果，使用此力場可以在很大的

溫度、壓力範圍內精準的預測出各種分子的結構、振動

以及熱物理等等性質。由於二氧化矽奈米粉體屬於無機

材料且聚亞醯胺聚合物屬於有機材料，因此我們選擇此

力場計算彼此之間的關係，為了引入代表性之體積元素

方法模擬奈米複合材料，模型種類選擇週期性模型，初

始絕對溫度設定 650K，密度設定 1.33g/cc，邊長設定為

36.37 Å。 

(2)  PI-SiOB2B奈米複材結構模型，此模型由 7 個聚亞醯胺分子

鏈以及 1 個二氧化矽奈米粉體所構成且二氧化矽球體置

於模型中央，採用Compass力場，週期性模型，初始絕對

溫度 650K，考慮在聚亞醯胺聚合物部分的密度與聚亞醯

胺單位原子結構模型幾乎相同，密度設定 1.433g/cc，邊

長設定為 37.39Å。 

聚亞醯胺單位原子結構模型以及PI-SiOB2B奈米複材結構模型如

圖 2-3(b)及(c)  所示，初始的幾何特性可以參照表 2-1，詳細

步驟可參閱附錄 4。 

5. 分子動力學模擬運算，經由上述步驟，初始的奈米複材模型

已經被建立，藉由分子動力學模擬出合理的奈米複材模型。

由於初步奈米複材模型的位勢能通常很高，導致在進行分子
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動力學模擬運算時產生能量無法收斂的問題，所以分子動力

學模擬運算之前，藉由 Discover 模組的 Minimizer 方法，些

微調整奈米複材模型的結構，使系統的位勢能達到最低且穩

定的狀態。詳細步驟可以參閱附錄 5。 

6. 之後進行分子動力學模擬運算，其中分析的時間間隔為 0.5 

femto-seconds (fs)，且在凡得瓦能量(van der Waals energy)部分

考慮 9.5Å 的截斷距離。主要分為二個過程，模擬的過程可以

參閱表 2-2： 

(1)  為了使聚亞醯胺聚合物能夠均勻的分佈在結構模型中，

在模擬過程中施加高溫，使原子能獲得足夠的動能進而

達到均勻的分佈在結構模型中。藉由 NVT（原子數(N)、

體積(V)及溫度(T)為定值）分析方法控制聚亞醯胺結構模

型的體積及溫度，使結構模型的絕對溫度達到 1500K，

分析時間為 20 picoseconds (ps)。 

(2)  我們希望在分析奈米複材模型時邊界壓力能在 0Pa 且絕

對溫度達到 1K，為了使模擬系統在降溫的過程中溫度是

緩慢的下降，在此將降溫過程分成兩個步驟： 

(a)  利用 NPT（原子數(N)、壓力(P)及溫度(T)為定值）

分析方法控制單位原子結構模型邊界上的壓力以及

系統溫度，使得結構模型的溫度達到 300K，邊界上

的壓力達到 0GPa，分析時間為 15 picoseconds (ps)。 

(b)  同樣利用 NPT 分析方法使得結構模型的溫度達到
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0K，邊界上的壓力達到 0GPa，分析時間為 20 

picoseconds (ps)。詳細步驟可以參閱附錄 6。 

    最後檢驗收斂過程，包括結構模型的溫度，動能，位能以及壓力，

確定分子動力學的模擬過程以達收斂，由上述的模擬過程，更可以確

信合理的聚亞醯胺單位原子結構模型以及PI-SiOB2B奈米複材模型已經

被建立，其最終的幾何結果可參閱表 2-3，接下來便是分析結構模型

的密度分佈及楊氏模數。 

 

2-1-2 密度分佈 

    對於聚亞醯胺單位原子結構如圖 2-4，A 為一具有週期性邊界條

件的聚亞醯胺單位原子結構模型，三邊長分別為 ( )c,b,a ，在計算密度

分佈時，如圖 2-5，取系統 A 的中心為球心，也就是座標位於 ⎟
⎠
⎞

⎜
⎝
⎛

2
c,

2
b,

2
a

的位置，並且以 dr 為增量取一球殼，其體積為 dV。我們假設原子的

重量集中於一點，不考慮原子的體積，即所謂的點質量(Point mass)

來計算在此 dV 內所含原子總重量 g，經由密度公式運算 

( )[ ]33 rdrr
3
4dV −+π=                                  (2.1) 

dV
g

=ρ                                              (2.2) 

即可球出在半徑
2
drr + 位置上其密度值。 
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    為了能夠更平均的表示聚亞醯胺單位結構模型的密度分佈，我們

分別取A系統另外三邊面上的中心，如圖 2-4，也就是P、Q及R三點，

其位置分別為 ⎟
⎠
⎞

⎜
⎝
⎛

2
c,

2
b,a ， ⎟

⎠
⎞

⎜
⎝
⎛

2
c,b,

2
a

以及 ⎟
⎠
⎞

⎜
⎝
⎛ c,

2
b,

2
a

三點位置為球心，半

徑範圍
2
ar0 ≤< ，在這三個位置上計算密度分佈的方法和前述一樣，

則密度分佈如圖 2-6，最後，將這四點位置所求得的密度分佈取平均，

其結果如圖 2-7。對於PI-SiO B2B奈米複材結構模型，我們取二氧化矽中

心位置為球心，計算其密度分佈如圖 2-8。由圖 2-6 及圖 2-7 可以看

出聚亞醯胺結構模型在接近球心的部分其密度有較大的變動，這是因

為這個位置時所選取的體積較小所造成的誤差，當距離較大時，密度

趨於穩定，其穩定值為 1.31g/cc，這個結果在合理的範圍值內[20]，

另外由圖 2-8也可以看出由這四個位置為球心所求得的密度分佈趨勢

一樣，所以可以知道此聚亞醯胺結構模型是一個擁有均質性的結構模

型，由圖 2-8 可以看出在聚亞醯胺的密度分佈在接近二氧化矽球體有

明顯的增加且在遠離球心部分密度接近 1.31g/cc，因此研判在聚亞醯

胺單位原子結構模型中添加二氧化矽球體對於聚亞醯胺密度分佈有

明顯的影響。  

 

2-1-3 徑向分佈函數 [21] 

    所謂徑向分佈函數、即局部原子數密度與總系統的原子數密度之

比值，用以描述系統內任一原子a在距離r搜尋到原子b的機率，以任

意原子a為球心，距離球心r至 drr + 的球殼層中發現b原子的數量fBnB除上

dr球殼的局部體積即為局部的數密度 nρ ，則徑向分佈函數可定義為: 
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( )
V

N
dr)1n(ndr4

f3

)r(g
33

n

0

n −−π
=

ρ
ρ

=    maxN,2,1n L=       (2-3) 

其中fBnB為 ndrrdr)1n( ab ≤≤− 範圍內相對兩原子距離 abr 的配對統計數

量，分別計算聚亞醯胺單位原子結構模型以及PI-SiOB2B奈米複材結構模

型對於聚亞醯胺聚合物的徑向分佈函數，如圖 2-9，則可以發現分佈

曲線幾乎相通同，因此可以推測對於聚亞醯胺單位原子結構模型以及

PI-SiOB2B奈米複材結構模型的基材部分的鬆緊程度是相同的，另外由於

凡得瓦能量是屬於非鍵結能，也就是說當距離相同時，則凡得瓦能量

也應相同，由於基材部分原子分佈的情形相同，所以可以知道在基材

部分的非鍵結能量也是相等。 

 

2-1-4 楊氏模數 

    計算結構模型的楊氏模數可藉由 Discover 模組的 Analysis 方法

[18]，首先施加在結構模型的一個方向施加應變，再計算此時所產生

的應力進而求出結構模型的楊氏模數，過程分為四個過程： 

1. 將單位原子結構模型做位能最小化的處理，使其位能達到一

個穩定值，在此過程中有兩個步驟： 

(1) 位能的計算，計算出結構模型中所含的位能，位能包括鍵

結能和非鍵結能，如 (2.4)、(2.5)和(2.6)式。 
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bondnonbondTotal UUU −+=                      (2.4) 

crosstermUBoop

torsionanglestretchbond

UUU

UUUU

+++

++=

                  
           (2.5) 

hbondcoulombvdwbondnon UUUU ++=−             (2.6) 

其中 stetchU 、 angleU 、 torsionU 、 oppU 、 UBU 和 crosstermU 為拉

伸、彎曲、扭轉、非平面(out of plane)、Urey-Bradley 以

及由 stetchU 、 angleU 、 torsionU 、 oppU 互相影響之鍵結能，

而 vdwU 、 coulombU 以及 hbondU 分別為凡得瓦力、庫侖力以

及氫鍵所產生之位能。 

(2) 構造的調整，藉由調整單位原子結構模型中原子的位置，

使整個結構模型的位能達到最穩定的狀態。 

2. 對三個方向分別給予拉伸以及壓縮應變(tension/compression 

strain)和剪應變(shear strain)( 0005.0± )，並保持其他方向應變

為 0。 

3. 再分別對變形後的結構模型作能量的最小化的處理，使其位

能達到另一個穩定值。 

4. 分別計算變形前與變形後的應力以及應變，應力計算方法採

用 Virial 理論[22]，所求得的應力稱為 Virial 應力 
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( )
⎥
⎥
⎦

⎤

⎢
⎢
⎣

⎡
+⎟⎟

⎠

⎞
⎜⎜
⎝

⎛
−=σ ∑∑

<= ji

T
ijij

N

1i

T
iii

0
frvvm

V
1                   (2.7) 

其中 im 表示各原子的重量，vBi B表示各原子的速度，rBijB表示原子

與原子之間的距離，fBijB表示原子間的內力。等號右邊的第一個

式子可看做系統的動能，而第二個式子則是系統的位能，由

於考慮結構模型溫度處在 1K的條件下，所以動能部分趨近於

0，於是Virial 應力可以簡化成 

⎟
⎟
⎠

⎞
⎜
⎜
⎝

⎛
−=σ ∑

< ji

T
ijij

0
fr

V
1                                 (2.8) 

藉由應力與應變的關係，我們可以得到勁度矩陣 C 以及楊氏

模數 

   
ij

ij
ijC

ε∆

σ∆
=                                        (2.9)            

    聚亞醯胺原子結構模型藉由施加應變方法求得楊氏模數為

3.678GPa，剪力模數為 1.332GPa，浦松比為 0.38，而PI-SiOB2B奈米複

材結構模型的楊氏模數則為 4.23GPa，剪力模數為 1.615GPa。為了求

得二氧化矽的楊氏模數，建立二氧化矽的單位晶格模型，如圖 2-10 

(a)，接著分別向x，y以及z三個方向建立相同的晶格圖 2-10 (b)，接著

利用MS軟體分析其機械性質，可知二氧化矽的楊氏模數為 83.9GPa，

剪力模數為 37.95GPa。 

2-2 非鍵結間距 
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    PI-SiO B2B奈米複材結構模型經觀測可發現在二氧化矽奈米粉體以

及聚亞醯胺聚合物之間有一間距，在這間距當中沒有任何原子存在，

如圖 2-11(a) 所示，此間距是由二氧化矽奈米粉體以及聚亞醯胺聚合

物互相作用造成，由於二氧化矽奈米粉體以及聚亞醯胺聚合物的交互

作用主要由非鍵結力，所以我們稱此間隔為非鍵結間距，為了要計算

出非鍵結間距的厚度，選擇二氧化矽奈米粉體的中心為球心，取一小

角度φ，如圖 2-11(b)所示，約為 20 度，則此角度內可分別發現二氧

化矽奈米粉體的原子群以及聚亞醯胺聚合物的原子群，對於二氧化矽

奈米粉體的原子群，可以發現距離球心最遠的一顆原子，而此原子距

離球心的距離稱為 max
SiO2

r ，同樣的對於聚亞醯胺聚合物的原子群也可發

現距離球心最近的一顆原子，原子距離球心的距離稱為 min
PIr ，則在此

角度內非鍵結間距由離球心最近的聚亞醯胺聚合物的原子距離以及

離球心最遠的二氧化矽奈米粉體的原子距離相減 

max
SiO

min
PIbondnon 2

rrr −=−                                  (2.10) 

其中 bondnonr − 為非鍵結間距，對 z 軸φ為間距，約 10 度旋轉一圈並且

取平均值，則可得到在二氧化矽奈米粉體以及聚亞醯胺聚合物之間的

非鍵結間距大小，結果可參閱圖 2-12，同樣的對 x 軸以及 y 軸旋轉一

圈並且取平均值，可得到非鍵結間距大小，結果可參閱圖 2-13 及圖

2-14，將所得到的兩個非鍵結間距值平均，可得到平均的非鍵結間距

為 4.3758Å，藉由此方法，我們可以成功的計算出非鍵結間距的厚度，

另外由此方法我們也可得到二氧化矽奈米粉體的半徑為 8.5034Å。 

2-3 非鍵結能量  
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    非鍵結能量包含凡得瓦能量以及電位能，其中凡得瓦能量

是原子與原子之間的非鍵結力所造成的能量，產生的原因是由於一個

原子周圍環繞的電子不是永遠都均勻地分佈，在某一瞬間電子會偏向

原子的一邊，讓這邊帶了些許負電，而另一邊則帶些許正電。當兩個

分子靠近時，這些片刻、些許的正負電之間也會互相吸引，因此產生

凡得瓦能量。藉由MS軟體，我們可以計算出PI-SiOB2B奈米複材結構模

型的非鍵結能量，PI-SiOB2B奈米複材結構模型非鍵結能量可看成聚亞醯

胺以及二氧化矽擁有的非鍵結能量再加上兩者之間交互作用所產生

的非鍵結能量 

interfaceSiOPITotal UUUU
2

++=                 (2.11) 

其中， TotalU 為PI-SiOB2B奈米複材結構模型全部的凡得瓦能量，其值為

moleKcal30116895.− ， PIU 為聚亞醯胺聚合物的凡得瓦能量，將

PI-SiO2 奈米複材單位結構中的二氧化矽奈米粉體移除，再計算能量

便可得到聚亞醯胺聚合物部分的能量，其值為 moleKcal8328.713- ，

2SiOU 為二氧化矽奈米粉體的凡得瓦能量，同樣的，將聚亞醯胺聚合

物部分的原子移除，在計算能量便可得到二氧化矽部分的能量，其值

為 moleKcal8361.116- ， interfaceU 為聚亞醯胺聚合物和二氧化矽奈米粉

體之間交互作用的凡得瓦能量，我們假設 interfaceU 是由於非鍵結能量

存在於奈米粉體的表面以及聚亞醯胺聚合物的內表面，由(2.12)式可

得 

mole
Kcal 205.471UU bondnoninterface −== −                (2.12) 

interfaceU 的單位為仟卡/莫耳(Kcal/mole)，其中一莫耳代表 23106 × 個數
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量，舉例來說，假設有一個氫分子，是由兩個氫原子所組成，其化學

式為HB2B，則一莫耳的氫分子則代表 23106 × 個氫分子，但是確有

231012× 個氫原子，而一莫耳原子則代表 23106 × 個原子。仟卡為能量

單位且 1 卡= 4.18 焦耳(J)，所以 interfaceU 是考慮在一莫耳的系統，也

就是 23106 × 個模擬系統所擁有的能量，考慮在單位面積上的非鍵結

能量 

A
UU bondnon'

bondnon
−

− =                                  (2.13) 

( )2
SiO2

r4A π=                                        (2.14) 

結果如表 2-4， '
bondnonU − 為單位面積上的非鍵結能量即正交化非鍵結

能量(Normalized non-bond energy)，由(2.14)式可得單位面積上的非鍵

結能量 2'
bondnon J/m 57541.U −=− 。 

 

 

 

 

 

 

第三章 微観力學模型 
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    本章節將介紹兩個微観力學模型，Mori-Tanaka 模型以及等效介

面層模型(Effective Interface Model)，Mori-Tanaka 模型主要闡述在一

個有限長的基材內部添加一個內含物的複合材料其整體的機械性

質，而等效介面層模型除了考慮基材以及內含物，另外也考慮了在這

兩者之間介面層的影響，另外利用有限單元法(Finite element method)

驗證 Mori-Tanaka 模型以及等效介面層模型，為了簡化問題，採用軸

對稱 RVE 模型分析奈米複材的機械行為。 

 

3-1 Mori-Tanaka 模型 

    Mori-Tanaka 模型只考慮複合材料中內含物以及基材部分對整體

機械性質的影響，推導如下 

 

3-1-1 Eshelby’s 等 值 內 含 物 理 論 (Eshelby’s equivalent 

inclusion theory) 

    如圖 3-1，考慮一個無限長的物體，其勁度矩陣(Stiffness matrix)

為 mC ，中間橢圓部分稱為內含物，假設在內含物部分獲得均勻的應

變(uniform strain) Tε ，值得注意的是此應變並不是由應力所造成，最

典型的例子如一個均質的塊材因溫度上昇而產生的熱應變。我們稱 Tε

為特徵應變(eigenstrain)。由於內含物和基材是黏接在一起，所以當內

含物施加特徵應變 Tε ，複合材料會產生應變場 )x(εC ，假設在基材

以及內含物的應力場分別為 )x(σm 以及 )x(σ f  
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(x)εC(x)σ Cmm =                                      (3.1) 

)ε(εCσ TCmf −=                                      (3.2) 
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=                                   (3.3) 
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=                                   (3.4) 
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44 GC =                                            (3.5) 
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C                  (3.6) 

其中EBmB為基材的楊氏模數， mν 為基材的蒲松比，而GBmB為基材的剪力

模數，Eshelby證明在內含物部分的應變 Cε 是一個均勻應變，並且和

特徵應變有著下面的關係[23] 

T
Esh

C εEε =                                          (3.7) 

其中EBEshB為Eshelby’s 張量，只與內含物的長短軸比(aspect ratio)及基

材的勁度矩陣有關，關於Eshelby’s張量詳細的數學模型可參閱文獻

[24]，若為球狀內含物，則Eshelby’s張量為 
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ijklEsh EE =                                           (3.8) 

)1(15
57

EEE
m

m
333322221111 ν−

ν−
===                         (3.9) 

)1(15
15

EEEEEE
m

m
332222111133331122331122 −ν

−ν
======     (3.10) 

)1(15
54

EEE
m

m
313123231212 ν−

ν−
===                        (3.11) 

    如圖 3-2 所示，考慮兩個無限長的複合材料，圖 3-2(a) 含有非均

質的內含物，其勁度矩陣為 fC ，圖 3-2(b) 含有與圖 3-2(a) 相同幾何

形狀均質的內含物，假設在邊界上皆施加一個均勻的應變 Aε ，我們

希望藉由在圖 3-2(b) 的內含物部分給予特徵應變 Tε 使得圖 3-2(a） 

以及圖 3-2(b) 有相同的應變及應力場。由圖 3-2(a） 我們可以得到在

非均質內含物部分的應變 fε 及應力 fσ  

CAf εεε +=                                         (3.12) 

 )ε(εCσ CAff +=                                     (3.13) 

如圖 3-2(b) ，為了使均質內含物和非均質內含物兩者的應力及應變

相等，我們在均質內含物加上特徵應變 Tε ，可以得到在均質內含物

部分的應變 fε 及應力 fσ  

CAf εεε +=                                         (3.14) 
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)εε(εCσ TCAmf −+=                                 (3.15) 

其中(3.14)式中的 Cε 是由於在內含物部分施加特徵應變而造成，如此

一來在兩個複合材料內含物部分的應變相等，圖 3-3 為施加 Aε 在基材

邊界上所造成非均質內含物部分的應力以及應變關係，圖 3-4 為施加

Aε 在基材邊界上所造成均質內含物部分的應力以及應變關係，圖 3-5

為施加 Aε 在基材邊界上以及施加特徵應變 Tε 於均質內含物上所造成

均質內含物部分的應力以及應變關係，考慮圖 3-3 以及圖 3-5 在內含

物部分的應力相等，則可得到 

)ε(εC)εε(εCσ CAfTCAmf +=−+=                     (3.16) 

藉由(3.3)式，則(3.16)式可寫成 

AmfT
Esh

mfm ε)CC(ε]E)C(C[C −=−+−                 (3.17) 

則我們已經藉由在均質內含物部分給予特徵應變而使得兩個複合材

料在內含物部分的應力及應變皆相等。由上面所推導，可以知道當無

限長的基材添加一個非均質的內含物，可以藉由特徵應變將此問題轉

化成均質的內含物問題。 

 

3-1-2 稀少的 Eshelby 模型( Dilute Eshelby model) [25] 

    考慮無限長的基材的複合材料，則在無窮遠處的均勻應變應等於

基材的平均應變 0ε  
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0A εε =                                             (3.18) 

由於在內含物的應變為均勻應變，所以平均應變 fε 為 

C0CAf εεεεε +=+=                                 (3.19) 

由(3.3)、(3.17)、(3.18)及(3.19)式，可以得到 fε 與 0ε 的關係 

01mfm
Esh

f ε)]C(CSE[Iε −−+=                          (3.20) 

1mm )C(S −=                                         (3.21) 

    Eshelby 所提到的是考慮在一個無限長的基材的問題，對於在一

個有限長的基材添加內含物的問題，Mori-Tanaka 提出了有效的方法 

 

3-1-3  Mori-Tanaka 模型[24][25] 

    考慮在無限長的基材添加非均質內含物，在一個有限長處將其取

出，如圖 3-6，則在虛線邊界上的應變可以看成在虛線以外部分的平

均應變 1ε ，由於在基材的部分包含了內含物，所以基材的平均應變 mε

可以看成邊界上的應變加上擾動應變(distribution strain) mε~   

m1m ε~εε +=                                         (3.22) 

同樣的，在內含物部分的平均應變 fε 可以看成 mε 加上擾動應變 fε~  

fm1fmf ε~ε~εε~εε ++=+=                             (3.23) 
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同樣的，如圖 3-7，考慮內含物的應力相等 

)εε~ε~(εC)ε~ε~(εC Tfm1mfm1f −++=++                  (3.24) 

比較(3.19)式及(3.23)式 

mm1A εε~εε =+=                                     (3.25) 

而擾動應變 fε~ 及可藉由特徵應變 Tε  

T
Esh

f εEε~ =                                         (3.26) 

由(3.18)、(3.20)、(3.25)及(3.26)式可得 

mEshelbym1mfm
Esh

f εAε)]C(CSE[Iε =−+= −                (3.27) 

考慮基材及內含物的體積比分別為 mv 及 fv ，則複合材料的平均應變

以及平均應力 

f
f

m
m εvεvε +=                                      (3.28) 

f
f

m
m σvσvσ +=                                     (3.29) 

εC*σ =                                            (3.30) 

其中 C*為等效勁度矩陣，將(3.28)式帶入(3.27)式，可以得到 fε 與 ε的

關係 

εAε MTf =                                          (3.31) 



 26

[ ] 1Eshelby
ff

EShelbyMT AνI)ν(1AA
−

+−=                    (3.32) 

由(3.28)至(3.32)式，可得 

( )( ) 1Eshelby
mf

Eshelbyf
m

m
f AνIνACνCν*C

−
++=              (3.33) 

    由(3.30)及(3.33)式，可以得到當非均質內含物加入基材，則整體

的有效勁度矩陣可以藉由(3.33)式求得。 

 

3-2 等效介面層模型[26][27] 

    此數學模型考慮複合材料中內含物、基材的機械性質之外，還考

慮了在內含物以及基材之間的介面層的機械性質對於複合材料機械

性質的影響，推導如下 

 

3-2-1 等值的雙層內含物理論(Equivalent Double Inclusion 

Theory)  

    如圖 3-8，在一個彈性常數為CP

M
P的無限長基材M，含有內含物V 並

且在V內部也含有內含物 Ω，假設在Ω部分獲得特徵應變 T
1ε (x)，即

特徵應變隨位置而改變，則在Ω部分的總應變 

 



 27

T
1EshΩ

C
Ω εΩEdxε Ω=∫                                    (3.34) 

∫=
Ω

T
1

T
1 dVε

Ω
1ε                                      (3.35) 

則在Ω部分的平均應變 C
Ωε 可藉由(3.35)式 

∫=
Ω

CC
Ω dVε

Ω
1ε                                       (3.36) 

T
1

Ω
Esh

C
Ω εEε =                                         (3.37) 

其中 Ω
EshE 表示在Ω部分的 Eshelby’s 張量， T

1ε  表示在Ω部分的平均特

徵應變。 

    藉由 Mori-Tanaka[28]的結果，(3.38)式表示當特徵應變施加在Ω

部分，則對Γ部分所造成的總應變同等於將特徵應變 T
1ε  施加在Γ部

分對Γ部分造成的應變再乘上Ω部分的體積 

T
1Esh

V
EshΓ

C
Γ ε)EΩ(Edx(x)ε Ω−=∫                           (3.38) 

T
1Esh

V
EshΓ

C
Γ

C
Γ ε)E(E

f1
fdx(x)ε

Γ
1ε Ω−

−
== ∫                   (3.39) 

其中 f 為Ω在 V 的體積比， V
EshE ， Ω

EshE 分別表示在 V 以及Ω部分的

Eshelby’s 張量 ，在 V 部分的總應變應為在Ω部分的總應變加上在Γ

部分的總應變，因此在 V 部分的平均應變 
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T
1

V
Esh

T
1Esh

V
Esh

T
1Esh

Γ
C
ΓΩ

C
Ω

C
V

εfE}ε)EΩ(E)ε(E {Ω
V
1

)dxεdxε(
V
1ε

=−=

+=

ΩΩ

∫∫

     
     (3.40) 

假設只有在Γ部分獲得均勻的特徵應變 T
2ε ，對各個位置所造成的應

變可以看成在 V 部分加上 T
2ε 所造成的應變以及在Ω加上 T

2ε 所造成的

應變相減的結果，如圖 3-9 及圖 3-10，其中箭號的左邊表示施加特徵

應變 T
2ε 的位置，箭號的右邊則表示在相對應位置產生的總應變，應

用疊加原理，如圖 3-10 (a) ，可知當Γ部分獲得特徵應變 T
2ε ，其各

部分的平均應變 

T
2Esh

V
EshΩ

C
Ω

C
Ω ε)E(Edxε

Ω
1ε Ω−== ∫                        (3.41) 

T
2

V
EshV

C
V

C
V εEf)(1dxε

V
1ε −== ∫                          (3.42) 

T
2Esh

V
Esh

T
2

V
EshΓ

C
Γ

C
Γ ε)E(E

f1
fEdxε

Γ
1ε Ω−

−
−ε== ∫            (3.43) 

值得注意的是若我們考慮在Γ部分獲得特徵應變 )x(εT
2 ，即Γ部分獲

得的特徵應變隨位置而改變，則(3.42)及(3.43)式便不會成立，同樣的

利用疊加原理，如圖 3-11，假設分別在Ω部分得到特徵應變 T
1ε (x)，

在Γ部分得到的特徵應變 T
2ε ，利用疊加原理可以得到各部分的平均

應變 

T
2Esh

V
Esh

T
1Esh

C
Ω ε)E(EεEε ΩΩ −+=                           (3.44) 
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)εε)(E(E
f1

fεEε T
2

T
1Esh

V
Esh

T
2

V
Esh

C
Γ −−

−
+= Ω                  (3.45) 

T
3

V
Esh

C
V εEε =                                         (3.46) 

其中 }εf)(1ε{fε T
2

T
1

T
3 −+= 。如圖 3-12，假設施加均質應變 Aε 在一無

限長，內部含有兩種不同內含物的基材，利用 Eshelby’s 等值內含物

理論，我們希望在(b)的Ω及Γ部分分別施加 T
1ε (x)及 T

2ε ，使得(a)與(b)

有相同的應力及應變場，分別考慮在Ω及Γ部分的平均應力相等 

)εε(εC)ε(εC T
2

C
Γ

AmC
Γ

AΓ −+=+                         (3.47) 

)εε(εC)ε(εC T
1

C
Ω

AmC
Ω

AΩ −+=+                         (3.48) 

將(3.44)至(3.45)式帶入(3.47)及(3.48)式，可得  

0εC)]εε(∆E
f1

fεE)[εC(C T
2

mT
2

T
1Esh

T
2

V
Esh

AmΓ =+−
−

++−     (3.49) 

0εC]ε∆EεE)[εC(C T
1

mT
2Esh

T
1Esh

AmΩ =+++− Ω              (3.50) 

其中 Ω−= Esh
V
EshEsh EE∆E 。由(3.49)及(3.50)式，最後我們可以得到 Aε 與

T
1ε 、 T

2ε 及 T
3ε 之間的關係 

AΩT
1 εΦε =        AΓT

2 εΦε =        AVT
3 εΦε =          (3.51) 
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11
EshEsh

12

EshEshEsh

1
Esh

Ω

)]C∆E
f1

f(E)C

∆E
f1

f(E∆E

)C[(EΦ

−Ω−

Ω

Ω

+
−

−+

−
−+

+−=

            

                        (3.52) 

)]C∆E
f1

f(E)C

∆E
f1

f)(EC(E

[∆∆Φ

2
EshEsh

11

EshEsh
1

Esh

Esh
Γ

+
−

−+

−
−++

−=

Ω−

ΩΩ

            

                         (3.53) 

m1mΩ1 C)C(CC −−=         m1mΓ2 C)C(CC −−=         (3.54) 

ΓΩV Φf)(1fΦΦ −+=                                  (3.55) 

由(3.44)至(3.46)式、我們知道各位置的平均應變 C
Ωε 、 C

Γε 及 C
Vε 與特徵

應變 T
1ε 與 T

2ε 的關係，由(3.43)至(3.47)式，我們知道特徵應變 T
1ε 與 T

2ε

和 Aε 之間的關係，最後我們可以推導出各位置的平均應變 C
Ωε 、 C

Γε 及

C
Vε 和 Aε 的關係 

AΩ
Esh

Γ
Esh

C
Ω ε)ΦEΦ∆E(Iε Ω++=                         (3.56) 

AΩ
Esh

Γ
Esh

V
Esh

C
Γ ε)Φ∆E

f1
fΦ)∆E

f1
f(E(Iε

−
+

−
+=           (3.57) 

AVV
Esh

C
V ε)ΦE(Iε +=                                 (3.58) 
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3-2-2 稀少的雙層內含物問題 

    與稀少的 Eshelby 模型相同，考慮無限長的基材，則在無窮遠處

的均勻應變應等於基材的平均應變 0ε  

0A εε =                                             (3.59) 

將(3.59)式帶入(3.56)至(3.58)式，可以得到平均應變與 0ε 的關係 

0di
Ω

0Ω
Esh

Γ
Esh

C
Ω εAε)ΦEΦ∆E(Iε =++= Ω                   (3.60) 

0di
Γ

0ΩΓVC
Γ εAε)∆EΦ

f1
fΦE)∆

f1
f(E(Iε =

−
+

−
+=          (3.61) 

0di
V

0VV
Esh

C
V εAε)ΦE(Iε =+=                          (3.62) 

 

3-2-3 等效介面層模型 

    與 Mori-Tanaka 模型相同[25]，考慮在無限長的基材添加非均質

內含物，在一個有限長處將其取出，如圖 3-13，則在虛線邊界上的應

變可以看成在虛線以外部分的平均應變 1ε ，由於在基材的部分包含了

內含物，所以基材的平均應變 C
mε 可以看成邊界上的應變加上擾動應

變 mε~  

m1C
m ε~εε +=                                         (3.63) 

同樣的，在Γ部分的平均應變 Γε 可以看成 C
mε 加上擾動應變 Γε~ ，在Ω部
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分的平均應變 Ωε 可以看成 Γε 加上擾動應變 Ωε~ ，值得注意的是 Γε 以及

Ωε 分別表示在Γ及Ω部分中全部的平均應變                                  

ΓΓ += ε~εε C
m                                         (3.64) 

ΩΓΩΓΩ ++=+= ε~ε~εε~εε C
m                             (3.65) 

同樣的，如圖 3-14，分別考慮Γ以及Ω部分的應力相等                     

)εε~ε(C)ε~ε(C T
2

ΓC
m

mΓC
m

Γ −+=+                         (3.66) 

)εε~ε~ε(C)ε~ε~ε(C T
1

ΩΓC
m

mΩΓC
m

Ω −++=++                (3.67) 

將(3.66)、(3.67)式與(3.47)、(3.49)式比較 

 C
m

A εε =                                            (3.68) 

而擾動應變 Γε~ 及 Ωε~ 可藉由特徵應變 T
1ε 及 T

2ε 分別施加在Ω及Γ部分 

CT
2

ΩVT
1

Ω ε)E(EεEε~ε~ ΩΩΓ ε=−+=+                      (3.69) 

CT
2

T
1

ΩVT
2

V )εε)(E(E
f1

fεEε~ ΓΓ ε=−−
−

+=                 (3.70) 

將(3.68)式及(3.70)式帶入(3.60)至(3.62)式，可以得到在Ω、Γ及 V 部

分的平均應變 C
Ωε 、 C

Γε 及 C
Vε 與基材的平均應變 C

mε 的關係 

C
m

di
Ω

C
Ω εAε =                                          (3.71) 
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C
m

di
Γ

C
Γ εAε =                                          (3.72) 

C
m

di
V

C
V εAε =                                          (3.73) 

另外假設基材的平均應變 C
mε 與整體的平均應變 ε的關係 

εAε m
C
m =                                           (3.74) 

其中 mA 為一未知數，將(3.74)式帶入(3.71)至(3.73)式，可以得到在

Ω、Γ及 V 部分的平均應變 C
Ωε 、 C

Γε 及 C
Vε 與全部的平均應變 ε的關係 

εAε Ω
C
Ω =                                           (3.75) 

εAε Γ
C
Γ =                                           (3.76) 

εAε V
C
V =                                           (3.77) 

同樣的， ΩA 、 ΓA 及 VA 皆為未知數。已知全部的平均應變 ε及應力σ

的關係 

εεvεvεv C
mm

C
ΓΓ

C
ΩΩ =++                               (3.78) 

σσvσvσv mmΓΓΩΩ =++                               (3.79) 

εCσ *=                                             (3.80) 

其中 Ωv 、 Γv 及 mv 分別為Ω、Γ及 m 的體積比， Ωσ 、 Γσ 及 mσ 分別

為Ω、Γ及 M 的平均應力。由於 C
Vε 與 C

Ωε 以及 C
Γε 之間的關係 
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)εΓε(Ω
V
1ε C

Γ
C
Ω

C
V +=                                   (3.81) 

將(3.75)至(3.77)式帶入(3.81)式 

ΩΓ

ΩΩΓΓ
V vv

AvAv
A

+
+

=                                  (3.82) 

將(3.81)式帶入(3.78)式，則可得 

εε)ν(νεv C
VΩΓ

C
mm =++                              (3.83) 

(3.83)式中 C
Vε 以(3.73)式帶入，且 ε分別以(3.74)及(3.76)式帶入 

C1C
m

di
Γ

C
mm )A(εA)vv(εv Ω

−
ΩΩΩ ε=++                     (3.84) 

C
V

1
V

C
m

di
Γ

C
mm )A(εA)vv(εv ε=++ −

ΩΩ                     (3.85) 

分別將(3.71)式帶入(3.84)式，(3.73)式帶入(3.85)式則我們可推得 ΩA

及 VA  

[ ] 1di
VΩΓm

di
ΩΩ A)v(vIvAA

−
++=                         (3.86) 

[ ] 1di
VΩΓm

di
VV A)v(vIvAA

−
++=                         (3.87) 

將(3.74)至(3.76)式帶入(3.78)式 

IAvAvAv mmΓΓΩΩ =++                              (3.88) 
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將(3.74)至(3.76)式以及(3.78)、(3.79)、(3.88)式帶入(3.80)式，可得到

等效勁度矩陣 

 

{ } { }Ω
mΩ

ΩΓ
mΓ

Γ
m

Ω
Ω

ΩΓ
Γ

Γm
m

m

A)C(CνA)C(CνC     

  ACνACvACv*C

−+−+=

++=
           (3.89) 

將(3.75)至(3.77)式帶入(3.81)式 

ΩΓ

ΩΩΓΓ
V vv

AvAv
A

+
+

=                                  (3.90) 

將(3.90)式帶入(3.89)式，則等效勁度矩陣可重新寫成 

}A)C{(Cv}A)C){(Cv(vC*C Ω
ΓΩ

ΩV
mΓ

ΩΓ
m −+−++=     (3.91) 

將(3.86)及(3.87)式帶入(3.91)式 

{ }
{ } { } 1di

VΩΓm
di
Ω

ΓΩ
Ω

di
V

mΓ
ΩΓ

m

]A)vv(Iv][A)C(Cν

ACC)vv[(C*C
−++−+

−++=

             
       (3.92) 

由(3.92)式，我們便可以求得當奈米粉體添加於奈米複材中的等效勁

度矩陣。 

 

3-3 有限單元法 

    利用有限單元法模擬複合材料在單軸方向施加拉伸應力並求得
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複合材料的楊氏模數，並且將此結果和 Mori-Tanaka 模型以及等效介

面層模型結果做一個比較。如圖 3-15 ，我們假設二氧化矽奈米粉體

為一完美球體並且置於六角形的聚亞醯胺聚合物中並且在兩端施加

應力 P，為了簡化問題，引入 RVE 觀念，可藉由取出其中一個複合

材料模型模擬整體複合材料的機械行為，如圖 3-15(b)及圖 3-15(c)，

令六角形的複合材料模型以及圓柱體複合材料模型體積相等 

3
0BA R2VV π==                                     (3.93) 

由(3.93)式可算出 584.20R 0 = Å 則此複合材料模型可更進一步的近似

為在軸向施加應力的圓柱體複合材料模型[29][30][31]，此為軸對稱

RVE 模型，因此我們可取其中一對稱面模擬軸對稱 RVE 模型。利用

有限元素分析軟體，ANSYS 10.0[32]，建立 RVE 模型並分析其楊氏

模數，選擇 Plane42 元素[32]，二氧化矽奈米粉體及聚亞醯胺聚合物

材料參數如表二，網格建立如圖 3-16(b)，考慮對稱性，則邊界條件

考慮在 0x = 位置 

( ) 0y,0u =                                           (3.94) 

其中 u 表示在 x 方向的位移，考慮週期性邊界條件，則邊界條件在

0Rx = 位置 

constanty),u(R 0 =                                   (3.95) 

邊界條件在 0y = 以及 0R2y =  

( ) constantx,0v =                                      (3.96) 
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( ) constantRx,2v 0 =                                   (3.97) 

其中 v 表示在 y 方向的位移。分別在 0y = 以及 0R2y = 處施加拉伸應

力 P，利用應力-應變關係，可以求出此軸對稱 RVE 模型的楊氏模數 

0R2
δ

=ε                                            (3.98) 

ε
Pmodulus  sYoung' =                                 (3.99) 

其中δ為在 y 方向長度的變化量，ε為在 y 方向的應變。另外考慮在

二氧化矽奈米粉體以及聚亞醯胺聚合物之間存在一介面層，則模型以

及網格建立如圖 3-17，同樣的，在分別在 0y = 以及 0R2y = 處施加拉

伸應力 P，則楊氏模數可由(3.98)式及 (3.99)式求得。 
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第四章 結果與討論 

     本章節將定義介面層的楊氏模數，利用線彈簧理論模擬非鍵結

間距的楊氏模數，並且將結果分別帶入 Mori-Tanaka 模型以及等效介

面層模型，再利用有限單元法驗證，並且將此結果與分子動力學模擬

結果做一比較，並且討論非鍵結間距以及採用不同階層的彈簧理論對

於介面層的楊氏模數以及奈米複材的楊氏模數的影響性。 

 

4-1 介面層之楊氏模數 

    為了利用連體力學概念來模擬奈米複合材料，必須定義出二氧化

矽奈米粉體以及聚亞醯胺聚合物之間交互作用的介面層，透過分子動

力學分析的結果的結果，我們知道在二氧化矽奈米粉體以及聚亞醯胺

聚合物之間有一非鍵結間距，假設介面層的厚度即為非鍵結間距，如

圖 4-1 所示，由於在介面層存在著非鍵結能量，利用線彈性彈簧理論

模擬此介面的非鍵結能量，在進一步利用一等效材料模擬此介面的彈

簧常數，如此一來非鍵結間距可適用連體力學模型進而描述出整體奈

米複合材料的機械行為。藉由表 2-4，我們知道在單位面積上的非鍵

結能量 2'
bondnon m/J5754.1U  −=− ，接著利用線彈性彈簧理論模擬單位

面積上的非鍵結能量 

2
bondnon

'
bondnon )r(k

2
1U −− =                                (4.1) 
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其 中 k 為 單 位 面 積 上 的 彈 簧 常 數 ， 由 (4.1) 式 可 得

319 m/N106455.1k ×= ，如此一來我們可以成功的藉由線彈簧理論模

擬介面層的非鍵結能量，並且將此部分的能量轉換成線性彈簧。 假

設有一長為 L，截面積為 A，楊氏模數為 E 的構件，如果在截面積上

施加軸向外力 F，如圖 4-2，考慮以線彈簧理論模擬此構件，可得到

彈簧常數
L

EAk = ，若 A 為單位面積，則在單位面積上的彈簧常數

L
Ek = ，藉由上述關係可將非鍵結間距藉由長為 bondnonr − 的構件模擬，

而構件的楊氏模數 E 

bondnonkrE −=                                          (4.2) 

值得注意的是上述的模擬方法僅考慮在軸向施加負載，而等效材料的

楊氏模數可由(4.3)式 

bondnonint krEE −==                                     (4.3) 

intE 為在介面層的等效楊氏模數，經計算其值為 7.2004GPa，假設蒲

松比為 0.3，則可求得剪力模數為 2.7694GPa。 

 

4-2 各種分析方法之比較 

    考慮二氧化矽奈米粉體，聚亞醯胺聚合物以及介質層的機械性

質，如表 4-1，再分別利用Mori-Tanaka模型、等效介面層模型以及有

限單元法分析PI-SiOB2B奈米複材結構模型的楊氏模數，在Mori-Tanaka
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模型中，二氧化矽奈米粉體以及聚亞醯胺聚合物的體積比分別為

4.7%及 95.3%，可求得PI-SiOB2B奈米複材結構模型的楊氏模數為

4.02GPa，在等效介面層模型中，體積比分別為 4.7%、11.63%及

83.67%，則可求出PI-SiOB2B奈米複材的楊氏模數為 4.362GPa，將有限

單元法分析的結果和分子動力學模擬、Mori-Tanaka模型以及等效介

面層模型所得到的楊氏模數比較，如表 4-2，可以發現以下幾點： 

1. 有限單元法分析的結果與 Mori-Tanaka 模型以及等效介面層模

型的結果非常接近，可以證明 Mori-Tanaka 模型以及等效介面

層模型所求得的楊氏模數有足夠的準確性。 

2. Mori-Tanaka模型所得的楊氏模數比分子動力學模擬所得的楊

氏模數其值較低，證明在PI-SiOB2B奈米複材結構模型中，除了聚

亞醯胺聚合物以及二氧化矽奈米粉體對於整體的楊氏模數有貢

獻之外，在兩者之間的介面層也應提供了機械性質。 

3. 等效介面層模型所的的楊氏模數比分子動力學模擬所得的楊氏

模數其值較高，其原因可能因為二氧化矽奈米粉體的晶格結構

並不是一個完美的球體，導致在二氧化矽奈米粉體以及聚亞醯

胺聚合物之間交互作用下產生的非鍵結間距並不是一個完美的

球殼，因此在計算介面層的厚度以及楊氏模數有些許的誤差存

在。 

 

4-3 結果與討論 
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    假設在單位面積上的非鍵結能量固定，考慮不同的非鍵結間距，

如表 4-3，可以發現奈米複材的楊氏模數隨著間距增加而些微降低，

而介面層的楊氏模數卻隨著間距減少而明顯增加，主要原因在於改變

非鍵結間距的大小，雖然介面層的楊氏模數上升，但是介面層在複合

材料中的體積比卻因非鍵結間距減少而下降，所以才會產生此現象。

另外，由於在模擬介面層的楊氏模數是採用線彈簧理論，若採用別種

方法模擬介面層的機械性質，其結果是否更為接近分子動力學模擬的

結果，考慮非鍵結間距固定，採用 nkxF = 模擬介面層的楊氏模數，

假設
2
1n = 、

3
1
、

4
1
、

5
1
，探討不同的n對於介面層以及PI-SiOB2B奈米複

材結構模型的楊氏模數的影響性，結果如表 4-4，可發現當n越小，則

介面層以及奈米複材的楊氏模數皆下降，外再考慮n = 1、2、3 … 6，

結果如表 4-4，可發現當n越大，則介面層以及奈米複材的楊氏模數皆

有明顯的上升，由上述的結果，可以知道定義出非鍵結間距的大小以

及選擇適當的模擬方法模擬介面層的楊氏模數是非常重要的關鍵，而

選擇適當的模擬方法的影響更大。 

    在Adrian和Sun[12]的分析中，可以知道當奈米粉體的半徑增大

時，其非鍵結間距幾乎沒有改變，將此結果套用在PI-SiOB2B奈米複材結

構模型，假設二氧化矽奈米粉體的半徑增大，但體積比不變，並且考

慮介面層的厚度固定，探討改變二氧化矽奈米粉體的半徑對PI-SiOB2 B奈

米複材結構模型的楊氏模數影響，如圖 4-3，可以發現當二氧化矽奈

米粉體半徑增大，則PI-SiOB2B奈米複材結構模型的楊氏模數會下降至

Mori-Tanaka模型所求得的結果，意味著當二氧化矽奈米粉體半徑增

大，介面層對於PI-SiOB2B奈米複材結構模型的影響愈見其微，其原因乃

在於二氧化矽奈米粉體半徑增大造成介面層的體積比下降，但是當二
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氧化矽奈米粉體半徑減少，則因為介面層體積比上升，導致介面層的

影響性增加，因此造成奈米複材的楊氏模數上升。 

    為了驗證二氧化矽奈米粉體粒徑對於奈米複材楊氏模數的影響

性，考慮建立另一個PI-SiOB2B奈米複材結構模型，其中聚亞醯胺分子鏈

內含 10 個聚亞醯胺單位結構，而二氧化矽直徑為 16.11Å，此模型由

4 個聚亞醯胺分子鏈以及 1 個二氧化矽奈米粉體所構成，考慮在聚亞

醯胺聚合物部分的密度與聚亞醯胺單位原子結構模型幾乎相同，密度

設定 1.513g/cc，邊長設定為 30.36Å，同樣的經由分子動力學模擬，

模擬過程如表 2-2，最後分析PI-SiOB2B奈米複材結構模型的密度分佈、

非鍵結間距以及計算其楊氏模數，密度分佈如圖 4-4，非鍵結間距如

圖 4-5、圖 4-6 及圖 4-7，楊氏模數經計算其值為 4.52GPa，另外利用

線彈簧理論進而模擬出介面層的楊氏模數為 10.4GPa，藉由等效介面

層模型計算PI-SiOB2B奈米複材結構模型的楊氏模數，可以發現結果與分

子動力學模擬結果相符合，將此結果與添加較大粒徑的二氧化矽奈米

粉體的PI-SiOB2B奈米複材結構模型比較，如表 4-5，可以發現添加粒徑

較小的二氧化矽奈米粉體的奈米複材模型其楊氏模數較大，此結果也

與之前預測的情形相符合。 

    另外Adrian和Sun[12]在 2005 年所發表的會議論文，同樣的也是

利用分子動力學模擬巴克球(Bucky-ball)添加於聚乙烯聚合物中，其中

聚乙烯的單位結構式為(-CHB2-B)，Adrian和Sun考慮三種不同大小的巴

克球分別放置於不同的聚乙烯單位原子結構模型，其中巴克球的直徑

分別為 7Å、12Å以及 17Å，體積比分別為 1.22%、1.87%以及 2.71%，

由表 4-6 可知PE單位原子結構模型的分子鏈中含有的單位結構、分子

鏈數以及分子量，此分子量為假設有 23106 × 條分子鏈的重量，首先將
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三種不同的聚乙烯單位原子結構模型模擬出聚乙烯聚合物的本體模

數(Bulk modulus)取一平均值，可得本體模數為 2.497GPa，同樣的，

將三種不同的聚乙烯單位原子結構模型模擬出聚乙烯聚合物的勁度

矩陣的CB11B取一平均值，可得CB11B為 3.364GPa，經由(4-4)至(4-6)式，可

以求出聚乙烯的楊氏模數為 1.79GPa，剪力模數為 0.65GPa 

 

µ+λ= 2C11                                           (4-4) 

)2(
3
1K µ+λ=                                          (4-5) 

µ+λ
µ+λµ

=
)23(E                                         (4-6) 

 

其中λ為藍姆常數(Lame constant)，µ為剪力模數，K為本體模數，之

後再利用分子動力學模擬聚乙烯聚合物的結構添加巴克球的整體機

械性質，經由分子動力學模擬結果發現當巴克球的半徑越小，則

PE-Bucky ball奈米複材結構模型的本體模數以及勁度矩陣的CB11B值會

上升，表 4-7 為分子動力學模擬的結果。藉由Adrian和Sun分析的數

據，考慮巴克球的楊氏模數為 12.7GPa，剪力模數為 4.7GPa[33]，而

聚乙烯的材料常數採用Adrian和Sun的結果，其詳細資料可以參閱表

4-8，其中正交化的非鍵結能量代表將非鍵結能量除上對應的巴克球

原子數量，利用 2-1-3 章節的方法求得介面層的楊氏模數，並且使用

等效介面層模型模擬奈米複材的楊氏模數，其中CB60B-PECB180B-PE以及

CB320B-PE 模型的介面層楊氏模數經計算分別為 19.9083GPa 、
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15.1431GPa以及 12.0499GPa，結果如表 4-9，可以發現在CB180B-PE以及

CB320B-PE的模型中，計算出的結果與分子動力學模擬過程的結果相近，

但是在CB60B-PE的模型中還是有些許的差距，但是結果仍然可以接受，

因此藉由線彈性彈簧理論模擬介面層機械性質的方法仍然可以模擬

PE-Bucky ball奈米複材結構模型的楊氏模數。 

    最後，針對聚亞醯胺單位原子結構模型，考慮不同的分子鏈長

度，探討分子鏈長度對於聚亞醯胺單位原子結構模型的楊氏模數的影

響，分別考慮內含 5、12、以及 35 個聚亞醯胺單位結構的分子鏈，

藉由分子動力學模擬分析，並且比較原子結構模型的楊氏模數，其結

果如表 4-10 及圖 4-8，可以知道當聚亞醯胺分子鏈所含的聚亞醯胺單

位結構越多，則所建立的聚亞醯胺單位原子結構模型的楊氏模數越

高，這主要原因在於當分子鏈的練長越長時，較容易發生纏繞的現

象，導致楊氏模數增加。 
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第五章 結論 

5-1 結論 

本研究乃藉由分子模擬技術瞭解奈米複材微觀材料結構，並進而推導

包含奈米特性的巨觀材料模型，以描述材料本構關係。文中將二氧化

矽奈米粉體添加於聚亞醯胺聚合物中，並利用分子動力學模擬複合材

料的機械性質，為了應用連體力學理論，藉由非鍵結間距以及介面層

的非鍵結能量模擬介面層的厚度以及機械性質，可得到下列結論； 

(1) 介面層的厚度以及剛性皆會影響奈米複合材料的機械性質，而

剛性又扮演著更重要的角色。 

(2) 藉由分子動力學模擬，計算出非鍵結間距，並且考慮介面層厚

度即為非鍵結間距，另外在奈米顆粒以及周遭基材部分的正交

化非鍵結能量提供了相當程度的訊息，並且利用線彈簧理論計

算介面層的楊氏模數。 

(3) 由於成功的定義出介面層的厚度以及剛性，利用等效介面層理

論可以精確計算出奈米則奈米複材的楊氏模數會增加，複合材

料的楊氏模數，分析結果顯示當奈米顆粒的粒徑下降，此結果

和一些文獻中實驗的結果相符。 
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5-2 未來工作 

    由於利用分子動力學模擬奈米複材的機械性質需要耗費大量的

時間，因此本文中僅針對一種基材以及加強材做探討，未來將會持續

的做以下的研究： 

(1) 研究適當的分子動力學模擬過程進而消除初始條件不同而造成

不同的結果。 

(2) 考慮不同的奈米粉體以及高分子聚合物所組成的奈米複合材料

並且利用等效介面層理論模擬奈米複材的楊氏模數，以確定本

研究所探討的正確性。 

(3) 由於目前所模擬的奈米複合材料其整體結構尺寸較小，未來將

模擬更大尺寸的奈米複合材料，並且利用粗粒化方法

(Coarse-grain method) 以降低模擬所需時間。 
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附錄 

    有鑑於 MS 軟體在台灣使用上並不普遍，所以此附錄乃詳細敘述

如何利用此軟體建立原子分子結構，並進行分子動力學模擬進而求得

模型的機械行為。 

 

附錄 1  建立聚亞醯胺單位分子結構 

    由於聚合物是由同一種單位分子所組合而成，所以必須建立聚亞

醯胺的單位分子結構才能進一步的建立聚合物，分為下列步驟： 

Step1: 首先建立新檔案，點選  “File” > “New” > “3D Atomistic 

Document”，接著在 “Project” 視窗下，點選 “3D Atomistic 

Document.xsd”，單擊滑鼠右鍵之後點選 “Rename”，將此檔案

名稱更改為 “imide.xsd”。如此一來，我們可以在此檔案中利

用 GUI 介面建立我們所需的分子式。 

Step2: 接著建立聚亞醯胺的單位分子結構，圖(2.1)是聚亞醯胺單位結

構的結構式，點選 “Sketch Ring”，在此選項內我們可以藉由

GUI 介面選擇建立由五個碳原子所組成的環(5 member)或是由
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六個碳原子所組成的環(6 member)，使用滑鼠點選其中一顆原

子，在“Properties”視窗下，在“Element Symbol” 位置雙擊滑鼠

左鍵，則可以修改原子種類，可將在環上的碳原子更改成氮原

子，點選 “Sketch Atom”，則可以藉由 GUI 介面建立我們所需

的氧及氫原子。 

Step3: 修改共價鍵數，使用滑鼠點選其中一個共價鍵，再點選 

“Modify” > “Modify Bond Type”，可以修改共價鍵的鍵數。 

藉由上述的方法，我們可以建立聚亞醯胺 單位結構，如圖(2.2)所示，

其中白色球體為氫原子，灰色球體為碳原子，紅色球體為氧原子以及

藍色球體為氮原子。 
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附錄 2. 建立聚亞醯胺分子鏈 

    聚亞醯胺分子鏈是由許多的聚亞醯胺單位結構所組成，為了能迅

速建立聚亞醯胺分子鏈，藉由複製聚亞醯胺單位結構以達到此目的，

首先點選 “Build” > “Build Polymers” > “Repeat Units”，接著點選聚亞

醯胺單位結構最左上方的氫原子，在  “Repeat Unit”視窗下點選 

“Head Atom”，再點選聚亞醯胺單位結構最右下方的氫原子，在 

“Repeat Unit”視窗下點選 “Tail Atom”，如此一來聚亞醯胺單位結構已

經複製。 

    考慮一個聚亞醯胺分子鏈含有 10 個聚亞醯胺單位結構，點選 

“Build” > “Build Polymers” > “Homo polymer”，在“Homo polymer”視

窗下： 

(a) “Polymerize” > “Library” > “Current project”。 

(b) “Polymerize” > “Repeat Unit” > “imide”。 

    步驟(a)以及(b)主要目的在於選擇所複製的聚亞醯胺單位結

構。 

(c) “Polymerize” > “Chain length” > “10”。 
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(d) “Polymerize” > “Number of Chain” > “1”。 

(e) “Advanced” > “ Orientation” > “Head-to-Tail”，(f) “Advanced” > 

“ Initiator” > “None”。  

(g) “Advanced” > “Terminator” > “None”。 

(h)將 Random 處打勾。 

    步驟(c)至(h)表示建立一個擁有 10 聚亞醯胺單位結構的聚亞

醯胺分子鏈，其中步驟(c)表示在每一個聚亞醯胺分子鏈擁有 10

個聚亞醯胺單位結構，步驟(d)表示建立一個聚亞醯胺分子鏈，步

驟(e)表示偉分子鏈中聚亞醯胺單位結構銜接的方法，步驟(h)表示

旋轉的角度為隨機分佈，其原因乃是聚亞醯胺聚合物是屬於不規

則的結構，最後按下 “Build”，則聚亞醯胺的分子鏈將會建立在 

“Polyimide.xsd”檔案中。 
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附錄 3  建立二氧化矽奈米粉體 

    建立二氧化矽奈米粉體之前，必須先建立足夠大的二氧化矽晶格

結構，同樣的，二氧化矽晶格可由二氧化矽單位晶格產生，在 MS 軟

體中已有內建，選擇“File” > “Import” > “Structure” > “metal-oxides”，

點選 “SiO2_quartz.msi” 之後按下“Import”，則二氧化矽單位晶格已

經被建立，接著點選 “Build” > “Symmetry” > “Super cell”，再“Super 

cell”視窗下，“A” > “10”， “B” > “10”，“C” > “10”，此步驟藉由二氧

化矽單位晶格分別在 x，y 以及 z 方向映射以建立足夠大的二氧化矽

晶格結構，最後按下 “Create Supercell”。由於奈米粉體近似球狀，所

以我們必須建立球形二氧化矽奈米粉體，點選  “ Edit” > “Atom 

Selection”，在“Atom Selection”視窗下： 

(a) “Select by property” > “ X Coordinate” > “Inclusive Range”，輸

入“ 23.2 To 23.6 ”， “Selection mode” > “Create a new selection 

from all visible atoms”，之後按下 “Select”。 

(b) 接著點選“Select by property” > “ Y Coordinate” > “Inclusive 

Range”，輸入“ 13.55 To 13.6 ”， “Selection mode” > “Select 

from the existing selection”，之後按下 “Select”。 
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(c) 點選“Select by property” > “ Z Coordinate” > “Inclusive 

Range”，輸入“ 27 To 27.2 ”， “Selection mode” > “Select from 

the existing selection”，之後按下 “Select”。 

步驟(a)至(c)主要目的在於選取二氧化矽晶格結構中心的 Si 原子。 

(d) 點選“Select by property” > “Radial Distance” > “Within”，輸入

“10”， “Selection mode” > “Create a new selection from all 

visible atoms”，之後按下 “Select”。  

    步驟(d)為以二氧化矽晶格結構中心的 Si 原子為球心，取半

徑 10Å，則我們已經選取建立球行二氧化矽奈米粉體所需的原

子，其中離球心最遠的原子距離為 9.78Å。 

(e) 點選 “Edit” > “Copy”，之後建立新檔案，點選 “File” > “New” 

> “3D Atomistic Document”，接著在 “Project” 視窗下，點選 

“3D Atomistic Document.xsd”，單擊滑鼠右鍵之後點選 

“Rename”，將此檔案名稱更改為 “SiOB2B.xsd”，接著點選 “Edit” 

> “Paste”，點選 “Build” > “Bonds” > “Calculate”。 
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    步驟(e)的目的在於將步驟(d)所選取的原子建立成球形二氧化矽

奈米粉體並儲存，則我們已經初步建立球形二氧化矽奈米粉體，最後

我們修改鍵結數，將鍵結數為雙鍵以及三鍵的共價鍵修改成單鍵，則

建立出完整的球形二氧化矽奈米粉體結構。 
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附錄 4  建立初始奈米複材結構模型 

    在MS軟體中，利用Amorphous Cell 模組建立初始奈米複材結構

模型，包含聚亞醯胺單位原子結構模型以及PI-SiOB2B奈米複材結構模

型，首先介紹如何建立聚亞醯胺單位原子結構模型，點選 “Modulus” 

> “Amorphous Cell” > “Construction”，如此一來會產生Amorphous Cell 

construction視窗，在 “Project” 視窗下，點選 “Polyimide.xsd”，接著

在Amorphous Cell construction視窗下： 

(a) “Construct” > “Constituent molecules”，點選 “Add”，接著將

Number 位置更改為 “7”，如此一來我們可建立擁有 7 條聚亞

醯胺分子鏈的聚亞醯胺單位原子結構模型。 

(b) “Construct” > “Temperature” > “650”， “Construct” > “Cell type” 

> “Periodic cell”， “Construct” > “Number of configurations” > 

“2”，步驟(b)表示以 650K 絕對溫度建立的週期性聚亞醯胺單

位原子結構模型，在 “Number of configurations”選項表示建立

原子結構模型的數量。 

(c) “Construct” > “Density” > “Target density of the final 

configurations” > “1.33”， “Construct” > “Density” > “Ramp 
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density from an initial value of” > “0.01”，此步驟表示建立的原

子結構模型的密度由初始 0.01g/cc 壓縮至 1.33g/cc，其主要目

的乃在於若選擇直接建立密度為 1.33g/cc 的原子結構模型因

空間過小而導致發生分子鏈穿過環的情形，因此必須先給定足

夠的空間，所以設定初始密度為 0.01g/cc。 

(d) “Setup” > “Energy evaluation” > “Forcefield” > “compass”，此步

驟表示建立原子結構模型所使用的力場為 Compass 力場，最

後按下 “Construct”，則初始聚亞醯胺單位結構模型已經被建

立。 

建立聚亞醯胺單位原子結構模型，同樣的點選  “Modulus” > 

“Amorphous Cell” > “Construction”，在  “Project” 視窗下，點選 

“Polyimide.xsd”，接著在 Amorphous Cell construction 視窗下： 

(a) “Construct” > “Constituent molecules”，點選 “Add”，接著將

Number 位置更改為 “7”。 

(b) 接著在“Project” 視窗下，點選 “SiOB2B.xsd”，之後在Amorphous 

Cell construction視窗下“Construct” > “Constituent molecules”，

點選 “Add”，接著將Number位置更改為 “1”。 
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   步驟(a)及(b)表示將建立一個擁有 7 條聚亞醯胺分子鏈以及 1

個球形二氧化矽奈米粉體的PI-SiOB2B奈米複材結構模型。 

(c) “Construct” > “Temperature” > “650”， “Construct” > “Cell type” 

> “Periodic cell”， “Construct” > “Number of configurations” > 

“2”。 

(d) “Construct” > “Density” > “Target density of the final 

configurations” > “1.423”， “Construct” > “Density” > “Ramp 

density from an initial value of” > “0.01”。 

(e) “Setup” > “Energy evaluation” > “Forcefield” > “compass”，最後

按下 “Construct”，則初始PI-SiOB2B奈米複材結構模型已經被建

立。 
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附錄 5  最小化處理  

    在進行分子動力學模擬運算之前，一般會先執行最小化處理，主

要原因在於建立初步奈米複材模型時通常會造成非常大的位勢能存

在於模型中導致在進行分子動力學模擬運算時有可能產生能量無法

收斂導致計算失敗的問題，點選 “Modulus” > “Discover” > 

“Minimizer”，在 Discover Minimization 視窗下： 

(a) 點選 “Method” > “Smart Minimizer”，此步驟表示選擇微調結

構的方法，其中方法有 Steepest Descent、Conjugate Gradient

及 Newton 三種，選擇 Smart Minimizer 表示在微調結構時會一

同考慮上述之三種方法[1]。 

(b) 點選 “Convergence level” > “Customized”，此步驟表示可自己

設定收斂所需的計算次數。 

(c) 點選 “Maximum iterations” > “2000”，此步驟表示設定計算次

數為 2000 次。 

最後點選 Minimize，則經由上述步驟，可以將原子結構模型的位

勢能降低且達到收斂。 
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附錄 6  分子動力學模擬過程 

    利用分子動力學模擬運算得到合理的奈米複材模型，在此分為兩

個過程： 

1. 升溫過程，點選 “Modulus” > “Discover” > “Dynamics” ，在

Discover Molecular Dynamics 視窗下： 

(a) 點選 “Dynamics” > “Ensemble” > “NVT”，此步驟表示分析

方法採用 NVT（原子數(N)、體積(V)及溫度(T)為定值）方

法。 

(b) 點選 “Dynamics” > “Temperature” > “1500”，此步驟表示控

制溫度在 1500K 絕對溫度。 

(c) 點選 “Dynamics” > “Time step” > “0.5”，此步驟表示分析

的時間間隔為 0.5 femto-seconds (fs)。 

(d) 點選 “Dynamics” > “Dynamics time” > “20”，此步驟表示分

析時間為 20 picoseconds (ps)。 

(e) 點選 “Dynamics” > “Trajectory” > “Save” > “Full”，此步驟

表示儲存原子所有的資料，包括原子位置、速度、溫度及
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能量等等。 

(f) 點選 “Dynamics” > “Trajectory” > “Frame output every” > 

“2000”，此步驟表示每計算 2000step 時儲存一次資料。 

最後點選 Run，則分子動力學開始運算。 

2. 降溫過程，分為兩個階段，第一階段為降溫至 300K 絕對溫

度，第二階段為降溫至 1K 絕對溫度。 

第一階段降溫點選 “Modulus” > “Discover” > “Dynamics” ，

在 Discover Molecular Dynamics 視窗下： 

(a) 點選 “Dynamics” > “Ensemble” > “NPT”，此步驟表示分析

方法採用 NVT（原子數(N)、壓力(P)及溫度(T)為定值）方

法。 

(b) 點選 “Dynamics” > “Temperature” > “300”。 

(c) 點選 “Dynamics” > “Pressure” > “0”，此步驟表示控制壓力

在 0GPa。 

(d) 點選 “Dynamics” > “Time step” > “0.5”。 
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(e) 點選 “Dynamics” > “Dynamics time” > “15”。 

(f) 點選 “Dynamics” > “Trajectory” > “Save” > “Full”。 

(g) 點選 “Dynamics” > “Trajectory” > “Frame output every” > 

“2000”。 

最後點選 Run，則分子動力學開始運算。 

第二階段降溫點選 “Modulus” > “Discover” > “Dynamics” ，

在 Discover                          Molecular Dynamics

視窗下： 

(a) 點選 “Dynamics” > “Ensemble” > “NPT”，此步驟表示分析

方法採用 NVT（原子數(N)、壓力(P)及溫度(T)為定值）方

法。 

(b) 點選 “Dynamics” > “Temperature” > “1”。 

(c) 點選 “Dynamics” > “Pressure” > “0”，此步驟表示控制壓力

在 0GPa。 

(d) 點選 “Dynamics” > “Time step” > “0.5”。 
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(e) 點選 “Dynamics” > “Dynamics time” > “15”。 

(f) 點選 “Dynamics” > “Trajectory” > “Save” > “Full”。 

(g) 點選 “Dynamics” > “Trajectory” > “Frame output every” > 

“2000”。 

最後點選 Run，則開始運算。 
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附錄 7  等效介面層模型程式 

clear all 
%------------------------------ 
%   Gm:   matrix shear modulus 
%   Em:   matrix young modulus 
%   vm:   matrix ratio 
%   Gp:   particle shear modulus 
%   Ep:   particle young modulus 
%   vp:   interface possion ratio 
%   Gi:   interface shear modulus 
%   Ei:   interface young modulus 
%   vi:   interface possion ratio 
%------------------------------- 
Gm=1.332; 
Em=3.678; 
vm=(Em/(2*Gm))-1; 
 
Gp=37.95; 
Ep=83.93; 
vp=Ep/(2*Gp)-1; 
v=vm; 
 
Ei=7.1455; 
vi=0.3; 
Gi=Ei/(2*(1+vi)); 
 
%--------------------------------- 
%   c1:   volume fraction of particle 
%   c2:   volume fraction of interface 
%   c3:   volume fraction of matrix 
%------------------------------- 
 
c1=0.0454 
c2=0.1147 
c3=0.8399 
 
%------Eshelby for isotropic spheral--------------- 
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%   Se:   Eshelby tensor 
%--------------------------------------------------- 
s11=(7-5*v)/(15*(1-v)); 
s22=s11; 
s33=s11; 
s12=(5*v-1)/(15*(1-v)); 
s21=s12; 
s13=s12; 
s31=s12; 
s23=s12; 
s32=s12; 
s44=(4-5*v)/(15*(1-v)); 
s55=s44; 
s66=s44; 
 
Se=[s11,s12,s13,0,0,0 
    s21,s22,s23,0,0,0 
    s31,s32,s33,0,0,0 
    0,0,0,s44,0,0 
    0,0,0,0,s55,0 
    0,0,0,0,0,s66]; 
%----------------------------- 
 
 
%------matrix [C]-------- 
cm11=Em./(1+vm)*(1-vm)/(1-2*vm); 
cm12=(Em./(1+vm))*(vm/(1-2*vm)); 
cm44=Gm; 
cm22=cm11; 
cm33=cm11; 
cm21=cm12; 
cm13=cm12; 
cm31=cm12; 
cm23=cm12; 
cm32=cm12; 
cm55=cm44; 
cm66=cm44; 
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Cm=[cm11,cm12,cm13,0,0,0 
    cm21,cm22,cm23,0,0,0 
    cm31,cm32,cm33,0,0,0 
    0,0,0,cm44,0,0 
    0,0,0,0,cm55,0 
    0,0,0,0,0,cm66]; 
%---------------------------- 
 
 
%------particle [C]--------- 
cp11=Ep./(1+vp).*(1-vp)./(1-2*vp); 
cp12=Ep./(1+vp).*vp./(1-2*vp); 
cp44=Gp; 
cp22=cp11; 
cp33=cp11; 
cp21=cp12; 
cp13=cp12; 
cp31=cp12; 
cp23=cp12; 
cp32=cp12; 
cp55=cp44; 
cp66=cp44; 
 
Cp=[cp11,cp12,cp13,0,0,0 
    cp21,cp22,cp23,0,0,0 
    cp31,cp32,cp33,0,0,0 
    0,0,0,cp44,0,0 
    0,0,0,0,cp55,0 
    0,0,0,0,0,cp66]; 
%------------------------------ 
 
%----------interface [C]------------ 
 
ci11=Ei/(1+vi)*(1-vi)/(1-2*vi); 
ci12=Ei/(1+vi)*vi/(1-2*vi); 
ci44=Gi; 
ci22=ci11; 
ci33=ci11; 
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ci21=ci12; 
ci13=ci12; 
ci31=ci12; 
ci23=ci12; 
ci32=ci12; 
ci55=ci44; 
ci66=ci44; 
 
Ci=[ci11,ci12,ci13,0,0,0 
    ci21,ci22,ci23,0,0,0 
    ci31,ci32,ci33,0,0,0 
    0,0,0,ci44,0,0 
    0,0,0,0,ci55,0 
    0,0,0,0,0,ci66]; 
%--------------------------------- 
 
%----effective [C]------------------- 
 
I=eye(6); 
Tp=I-Se*inv(Se+inv(Cp-Cm)*Cm); 
Tpi=I-Se*(c1/(c1+c2)*inv(Se+inv(Cp-Cm)*Cm)+c2/(c2+c1)*inv((Se+inv(Ci-Cm)*C
m))); 
Ceff=Cm+((c1+c2)*(Ci-Cm)*Tpi+c1*(Cp-Ci)*Tp)*inv(c3*I+(c1+c2)*Tpi); 
 
D=inv(Ceff); 
elastic=1/(D(1,1)); 
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表 1-1  A 與 B 材料的機械性質 

Material A B 

Young’s modulus (GPa) 3 70 

Possion’s ratio 0.3 0.3 

 

表 1-2 比較藉由有限單元法分析代表性之體積元素模型的楊氏模數 

 RVE 1 RVE 2 

Young’s modulus (GPa) 4.56GPa 4.56GPa 

 

表 2-1 聚亞醯胺以及PI-SiOB2B奈米複材進行分子動力學模擬前的特性 

  PI PI-SiOB2B 

No. of unit in polymer chain 10 10 

No. of chain in polymer model 7 7 

No, of SiOB2 B - 1 

Radius of particle (Å) - 9.79 

Initial density of composite (g/cc) 1.33 1.433 

Forcefield Compass Compass 

Constructional Temperature (K) 650 650 

Initial density of matrix (g/cc) 1.33 1.324 

Cubic length (Å) 36.37 37.39 
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表 2-2  分子動力學模擬過程 

Process 1 2 3 

Method NVT NPT NPT 

Forcefield Compass Compass Compass 

Target Temperature (K) 1500 300 1 

Time step (fs) 0.5 0.5 0.5 

Number of steps 40000 30000 40000 

Dynamic time (ps) 20 15 20 

Target pressure (GPa) - 0 0 

 
 

表 2-3  聚亞醯胺以及PI-SiOB2B奈米複材進行MD模擬後的特性 

 PI PI-SiO2 

Radius of particle (Å) - 8.5034 

Non-bond gap (Å) - 4.3758 

Volume (ÅP

3
P) 48827.6 54796.1 

Density (g/cc) 1.31 1.34 

Volume fraction (%) - 4.7 

 

表 2-4  PI-SiOB2B奈米複材介面層的非鍵結能量 

 PI-SiOB2B 

Energy(Kcal/mole) -205.471229 

Energy per unit area(J/mP

2
P) -1.6116 

Non-bond gap(Å) 4.3758 
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表 4-1 各種材料以及介面層之楊氏模數以及剪力模數 

 SiOB2 B Polyimide Interface 

Young’s modulus (GPa) 83.9 3.678 7.2004 

Shear modulus (GPa) 37.95 1.332 2.7694 

 

 

表 4-2 藉由不同方法所得PI-SiOB2B奈米複材的楊氏模數 

 
MD 

simulation 

Mori-Tanaka 

method 

FEM with 

two phase 

Effective 

interface 

model 

FEM with 

three phase

Young’s 

modulus 

(GPa) 

4.23 4.02 4.01 4.362 4.361 

 

 

表 4-3 不同的非鍵結間距對楊氏模數造成的影響 

Non-bond gap (Å) Interface modulus(GPa) Model prediction (GPa) 

6.5813 4.7637 4.2627 

4.3875 7.2004 4.364 

2.19375 14.2911 4.257 

1.096875 28.5822 4.1581 
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表 4-4  各種模擬方法與楊氏模數的比較 

Force field model Interface modulus(GPa) Model prediction (GPa) 

5
1

xkF 5=  0.8575 3.4872 

4
1

xkF 4=  1.1165 3.5580 

3
1

xkF 3=  1.5879 3.6722 

2
1

xkF 2=  2.6796 3.8819 

xkF 1=  7.1455 4.342 

2
2xkF =  21.4366 4.7711 

3
3xkF =  42.87 4.9352 

4
4xkF =  71.45 5.01 

5
5xkF =  107.18 5.051 

6
6xkF =  150.05 5.07 
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表 4-5  比較不同粒徑的二氧化矽奈米粉體 

  PI-SiO2 (Large) PI-SiO2 (Small) 

Particle radius (Å) 8.5034 6.5564 

Non-bond gap (Å) 4.3758 4.163 

Normalized non-bond energy (J/m2) -1.5754 -2.1846 

Volume fraction (%) 4.47 3.87 

Young’s modulus of interface (GPa) 7.2004 10.4945 

Young’s modulus (GPa) (MD simulation) 4.237 4.52 

Young’s modulus (GPa) (Effective 
interface model) 

4.352 4.5224 
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表 4-6 PE 單位原子結構模型的分子鏈性質[13] 

 PE-I PE-II PE-III 

No. of Chains in 

PE 
1 4 7 

No. of unit in chain 493 538 527 

Molecular Weight 

(g/mole) 
6915 7546 7392 

 

 

表 4-7 PE-Bucky Ball 奈米複材的幾何以及機械性質[13] 

 C60-PE C180-PE C320-PE 

Particle diameter (Å) 7 12 17 

Cubic length (Å) 24.49 36.43 45.6 

Non-bond Gap(Å) 3.394 3.436 3.478 

Volume fraction 1.22% 1.87% 2.71% 

UVDW(kcal/mole) -74.9 -169.5 -274 

Normalized 

UBnon-bondB(kcal/mole-atom) 
-1.2483 -0.9416 -0.8562 

Young’s modulus (GPa) (MD 

simulation) 
2.87 2.4422 2.183 
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表 4-8 PE 及巴克球的機械性質[12][33] 

 PE[12] Bucky-ball[33] 

Young’s modulus(GPa) 1.79 12.7 

Shear modulus(GPa) 0.65 4.7 

 

 

表 4-9  藉由各種方法模擬奈米複材的楊氏模數 

 C60-PE C180-PE C320-PE 

Volume fraction 1.22% 1.87% 2.71% 

MD simulation (GPa) 2.87 2.4422 2.183 

Effective interface model 

(GPa) 
2.1124  2.0233 2.0221 

 

 

表 4-10  比較不同的 PI 分子鏈長度 

  PI-1 PI-2 PI-3 PI-4 

No. of unit in 
PI chain 

5 10 12 35 

No. of chain in 
PI model 

14 7 10 2 

Density (g/cc) 1.33 1.31 1.31 1.31 

Young’s 
modulus 

(GPa) 
3.043 3.67 3.95 4.53 
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RVE 1                            RVE 2 

圖1-1 考慮不同顆粒大小但體積比相同的代表性之體積元素模型(representative 

volume elements ,RVE) ，體積比為19.6%  

 
圖 1-2 複合材料之介面層現象[17] 
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圖 2-1 聚亞醯胺分子結構式 

 

 

 

 

 
圖 2-2 利用 MS 軟體所建立的聚亞醯胺分子結構式 
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(a)  

 

(b)  

(c)  

 

圖 2-3 分子結構模型 (a) 二氧化矽奈米粉體 (b) 聚亞醯胺單位原子結構模型 (c) 

PI-SiOB2B奈米複材結構模型 
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圖 2-4  聚亞醯胺單位原子結構示意圖 
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圖 2-5 計算密度分佈示意圖 
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圖 2-6  聚亞醯胺單位原子結構模型之密度分佈 
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圖 2-7  聚亞醯胺單位原子結構模型之平均密度分佈 
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(Å) 



 83

Radius

D
en

si
ty

(g
/c

c)

8 10 12 14 16 18
0

0.2

0.4

0.6

0.8

1

1.2

1.4

1.6

1.8 PI
SiO2

1.31g/cc

 

圖 2-8  PI-SiOB2 B奈米複材結構模型密度分佈示意圖 
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圖 2-9  徑向分佈函數 

(Å) 

(Å) 



 84

 

(a) 

 

(b) 

圖 2-10  二氧化矽晶格模型  (a)單位晶格  (b)分析的晶格模型 

 



 85

φ

(a)

z

y

  

(b)

y

z

x

θ
φ

 
圖 2-11  非鍵結間距示意圖 (a) 平面圖 (b) 計算間距示意圖 
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圖 2-12  繞 z 軸旋轉之非鍵結間距
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圖 2-13  繞 y 軸旋轉之非鍵結間距 
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 圖 2-14  繞 x 軸旋轉之非鍵結間距 
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圖 3-1 Eshelby’s 內含物問題( Eshelby’s inclusion problem) (a).無施加應力的基材 

(b)在內含物施加特徵應變 (c) 基材和內含物產生應變場 

13.0554Å 

8.6959Å 

Non-bond gap: 4.3595 Å

(Å
)
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圖 3-2  Eshelby’s 等值內含物問題(Eshelby’s equivalent inclusion problem) 

 

 

圖 3-3  施加 Aε 之非均質值內含物的應力及應變關係示意圖 

 

CAf εεε +=

( )CAff εεCσ +=

Aε
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圖 3-4  施加 Aε 之均質值內含物的應力及應變關係示意圖 

 

 
 

 

 

圖 3-5  施加 Aε 以及 Cε 之均質值內含物的應力及應變關係示意圖 
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1ε

0ε
m1 ~ε ε+

fm1 ~~ε εε ++  

圖 3-6  有限長的基材添加內含物的問題  
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圖 3-7 在有限長的複合材料的等值內含物問題 
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圖 3-8 等值雙層內含物(equivalent double inclusion) 
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圖 3-9 施加特徵應變及相對應位置的總應變示意圖 (a) 施加特徵應變於Ω及Γ

處所造成的總應變 (b) 施加特徵應變於Ω及處所造成的總應變 
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圖 3-10 在Γ處施加特徵應變所造成的總應變示意圖 (a) 疊加原理示意圖 (b) 

施加特徵應變於Γ處所造成的總應變 
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圖 3-11  疊加原理示意圖 
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圖 3-12 等值雙層內含物問題(equivalent double inclusion problem) (a) 非均質之

雙層內含物 (b) 均質之雙層內含物 
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圖 3-13  有限長的基材添加雙層內含物的問題 
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圖 3-14  在有限長的複合材料的等值雙層內含物問題 

 

 

 

圖 3-15 軸對稱 RVE 模型模擬奈米複材示意圖 (a) 六角形奈米複材模型 (b)考慮

RVE 之六角形奈米複材模型 (c)軸對稱 RVE 模型 
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圖 3-16 不考慮介面層之軸對稱 RVE 模型 (a) 軸對稱 RVE 模型 (b) 有限單元法

模擬之軸對稱 RVE 模型 

P

P

2R0

R0

x

y

P

P  

 

圖 3-17 考慮介面層之軸對稱 RVE 模型  (a) 軸對稱 RVE 模型 (b) 有限單元法

模擬之軸對稱 RVE 模型 
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圖 4.1  模擬介面層示意圖 

 

 

 

 

圖 4.2  單軸受力之構件 
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圖 4- 4  PI-SiOB2 B奈米複材結構模型密度分
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圖 4-5  繞 z 軸旋轉之非鍵結間距 

 
圖 4-6  繞 y 軸旋轉之非鍵結間距 
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圖 4-7  繞 x 軸旋轉之非鍵結間距 
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圖 4-8 聚亞醯胺單位原子結構模型之楊氏模數  
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